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Introduction 

Telmar’s Media360 serves as both a print-only and a multi-media reach and frequency analysis system. Users can 
plan media simultaneously, including print, radio, TV, Web, cinema and beyond. The system runs standalone data or 
integrated studies (e.g. MRI or MRI integrated with Nielsen TV) 

● Single or Multiple schedules 
● Analyze multiple targets at once 
● Input screen dynamically changes to reflect measures relevant to media type (e.g. insertions, spots, 

GRPs, Run-of-Site, Days, etc...) 
● Cumulative Coverage, Cost, Difference and Composition Ranks 
● Optimization routine 
● Duplication analysis report 
● Create new targets and add new vehicles on the fly 
● Frequency distribution and N-Tiles reporting 
● Impact and Audience weighting functions 
● Excel and PDF exports 
● One-button access to rank, sort reports, what-if analyses 
● Ability to create and save user defined cost files 
● Graphing: single-click charts exportable to presentation, word processing or spreadsheet software 
● Report customization and saving as your own style 
● Targets can be standard demos, buying targets, or Telmar-generated clusters 
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Calculation Methodologies 
Metrex  

Has been an industry-accepted methodology for years. It uses both average the audience (single-use reach) and 
frequency-of-reading (last four issues) MRI data points to develop an estimate of average audience and self-pair 
reach. These two data points, the one-issue reach and the two-issue reach, are used to estimate the reach build 
from one to n insertions for a given vehicle. The cross-pair audience data are used to estimate the cross-pair reach 
of each pair of vehicles in a schedule. 

TruCume  

Is a newer reach calculation method that can take into account the same data as Metrex uses, but also the screen-in 
question known in print as the six-month screen. The effect of using the additional data points is that the shape of 
the reach build for each vehicle has a built in cap at the number of issues published in a six-month period of time. 
Reach build can continue beyond that number of issues, but the third data point tends to temper the rate of reach 
build. The cross-vehicle roll-up of schedule reach also benefits from the effect of the third data point for each 
vehicle. 

Single Media/Multiple Media 

Single Media schedules are created from single sourced surveys. However Media 360 also works with Profile 
Matching surveys and Multi-Based Surveys. 

Both Profile Matching and MultiBasing projects are designed for linking studies to enable the user to define targets 
as well as natively measured media from one study and measured media currency data from another for the 
purpose of cross tabbing and Reach/Frequency evaluations. 

Typically a national syndicated study like MRI or Simmons is used because of the richness of the demographic, 
product usage and lifestyle data as well as their print media measurements. This type of study is called the hub. A 
study like Nielsen television is used to “donate” currency television measurement data to be used in along with what 
the hub study offers. This type of study is called the donor. 

Both Profile Matching and MultiBasing projects start with defined targets that are common to the hub and donor 
studies; these are selected via an analysis as the variables maximally predictive of TV viewing. This predictive profile 
is coded to bring the studies together at the time of cross tabulation. 

With both Profile Matching and MultiBasing, at run time, demo targets that are common to both studies can be 
selected to evaluate television audiences from the currency study and the reported audiences for those measured 
demographics will be the same from Profile Matching or MultiBasing. For targets that only exist in the hub study 
(product usage, etc.), television audiences are solved differently in Profile Matching and MultiBasing. ​Profile 
Matching relies on demographic linkages alone while MultiBasing contains television (surrogate) linkages as well. 

Profile Matching uses only the demographic variables that were selected as maximally predictive of TV viewing to 
estimate television program or daypart audiences for all targets. If lifestyle or product usage estimates need to be 
calculated for the television vehicle, an evaluation of the relative contribution of the common demos to the ​target​’s 
profile is done and applied to the demographic ratings of the television vehicle to obtain a demographically based 
estimate of the rating within the target group. 

MultiBasing adds vehicle ​surrogates ​to the evaluation process. Television surrogates are coded and used within the 
hub study to capture the demographic relationships of the target within the context of viewers to the television 
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vehicle in the hub study. The vehicles’ surrogate-based audience within the target group is known because both the 
lifestyle or product usage target and the surrogate media measure are asked in the hub study. 

Wizards 

The Wizards will take you through all the steps to create a Ranker, (whether it is a Cost Ranker, Coverage Ranker) 
Single schedule (single target or multi-target), Multiple Schedules (add as many as you like), Cumulative Reach, and 
Optimization (Optimize by Cost, Reach%, or by a given GRP level). 

Rank Mode 

Rank Mode allows for ranking media by Composition, Coverage, Cost, or other factors that you select against a 
given target audience(s). 

Single Schedule 

Single schedule mode allows for view of single target audience with or without costs. Most users will start with this 
mode, as it is the easiest to follow, and can be changed to any of the other modes at any time. 

Multi-Schedule 

Using this mode gives you the option of viewing multiple schedules at the same time, it also allows for multiple 
targets with multiple schedules. 

Cumulative Reach 

Cumulative Reach mode uses a multi-schedule screen to calculate the reach build for a user supplied insertion level. 

Optimization 

Optimization can be carried out to achieve a specified level of reach or frequency or to satisfy a GRP level or a given 
budget; in addition the system devises optimal schedules for all stages between user-entered lower and upper 
expenditure limits. If the budget is subsequently increased or decreased, the planner then knows what the new 
schedule should be without having to start the schedule construction procedure again from the beginning. 

Media360’s almost exhaustive optimization lends itself to all forms of media audience and accumulation data 
constructs, and provides truly media neutral cross-media results. There will be further discussion of optimization 
later in this manual. 
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DIY 

Opening an Existing File 

This button allows for retrieval of a previously saved schedule file. Media360’s file format is *.MPFX. When clicking 
on this button, the last 10 files saved will display for a quick shortcut to the most recent work. For anything not 
listed, use the “Browse for File” menu item, and a standard Windows dialog will appear. 

Expert Mode 

This option takes you straight into a blank screen where you can manually select the schedule you wish to view and 
load the target audience and media vehicles.. 

Exit 

Use the File/Exit menu to close and exit from the application. 

 

Creating a Target Demographic File 
The first step to running a Reach & Frequency schedule analysis is to create the Target and choose the media 
vehicles that will be used for the analysis. 

 

What is a DEU file? 

The *.deu file is the default file format for tabulated demographic and media files that are used in Media360. A 
*.deu file can be used as many times as the user likes with many different schedule scenarios. You can start a new 
*.deu file from any of the wizards. 

1. Click on Single Schedule in the wizard screen, or choose File/New from the File Menu, or click the New 
button on the toolbar. 

2. The list of available target (.deu) files will be displayed. 

3. Click on the New Target button. 
 

4. The Survey Selection screen will display, with a dialog box the enables the user to only display a portion of 
the available surveys. Users may choose from (most recent year, last 2, 3, 4, or 5 years, or all years). Click 
OK. 
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5. The list of subscribed surveys will appear. 

6. Options on the Select Survey Screen allow the user to filter based on singles stand-alone surveys or 
Multi-Base integrated surveys (fusion on the fly). You may also filter the list by Survey Code or Survey 
Description 

7. You can also use the Search function to look anywhere in the title of the survey, or From Beginning. 

8. Select a survey to work with and choose the OK button. 
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Coding Screen 

9. Using the Boolean operators, code together the parts that will become your target demographic population. 
You can code multiple targets on multiple rows, and they will all be available for analysis on the same 
schedule window. 

10. Click the Next button in the lower right of the coding screen window to proceed. 

 

Choosing Media 

11. The next screen will be where the media vehicles that will be used in the schedule analysis are chosen from. 
Select them from the categories on the left, and move them to the right to select. 

12. Click OK to tabulate the *.deu file. 
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13. When the *.deu file is tabulated, the Costs dialog box will appear. If you have a cost file, click on File, if you 
do not currently want to use a cost file, click on Ignore. (You can always input the costs at a later time.) 

14. Clicking on Manual will open a dialog box where you may input costs immediately. Click on the OK button 
when done. 
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Planning Screen 

 

Inputting a schedule 

Schedules are calculated by inputting the number of Insertions, Spot Levels or GRP’s needed for each vehicle in the 
schedule. Different Media will display different wording for the media type being planned for. Totals are calculated 
at the bottom of the screen. 

Adding or Removing Target 

You may add an additional target(s), or remove any target from viewing, by hovering the mouse over the tab with 
the target name displayed, and right clicking the mouse to display a menu list. 

Choose the Change Target option, and the target coding dialog will appear with the current target showing on the 
first row. Simply add an additional target on row 2 if you want to keep the original target, or delete row 1 and 
re-code a new single target *.deu file. The new results will update automatically. 

 

 

For further information, please call your Telmar client service representative or email​ ​accountservices@telmar.com​    ​- ​11 - 

mailto:accountServices@Telmar.com


 

User Manual - Media360   

 

Adding or Removing Media 

Removing media vehicles from an analysis is very easy. Click on the button for Media from the toolbar. 

This will display the Media Selection dialog box again. Simply move the media vehicles from the right side to the left 
side to deselect and remove from the analysis, or move the media vehicles from the left to the right to add them to 
the analysis. Clicking OK will then start the tabulation process. When it is done, the schedule window will display and 
show the newly added/removed media vehicles. 

Using a cost file 

Telmar provides an open rate magazine cost file for use with Media360. To use this cost file, choose the “Cost” 
button from the toolbar. Choose “Central Files” from the dialog, and then choose the USA or the Canadian rate card 
file. The rates will automatically be updated on screen. 

 

Optimization 

● Select a demographic target (*.deu) by highlighting the file name and clicking Open. 
 

● Make sure that there are no insertions placed in any publications, then click on the Optimization Mode 
button on the toolbar. This adds the minimum and maximum insertions columns to the schedule and 
an Optimize Button to the schedule window. You can insert the required numbers against the minimum 
and maximum insertions columns for each publication as required. 
 

● Click on the Optimize Button in the schedule window. The cost dialog box will appear. You will need 
costs to optimize to a specific budget level. If you are optimizing on a reach, or GRP goal, you do not 
have to add costs. Make the appropriate choice to proceed. 
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Optimization Strategies 

If you do not use costs you are asked how you want Media360 to calculate your schedule. 

 

Equal Costs 

If you select the Equal Costs option, the optimization will give each publication an equal cost internally; this will 
mean that Media360 will place more insertions in the higher-reaching publications. You should achieve your Reach 
Goal with fewer insertions in this mode than in the Equal CPM option. 

Equal CPT  

The Equal CPT option will give each publication an Equal CPT internally, which will treat each title more fairly. 
Therefore, Media360 should place more insertions in the schedule than when using the Equal Cost option.  This will 
be a more realistic schedule if you are planning on a CPT basis. 

The user can also change the number of Optimization Results to be displayed. Once the optimization strategy has 
been achieved the Optimization will finish and the results will be displayed in the Totals Window of the planning 
screen. To return to a Single Schedule, click on the heading of Single Schedule, select the Optimized Schedule you 
wish to keep and click OK. 
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Duplicating a Publication/Media Vehicle 

You may wish to duplicate a publication to account for the qualitative values of different ads in the same schedule, 
(i.e. the page size, black & white, color ads.) 

To duplicate a publication right-click on the title of the publication and a menu will appear, select Duplicate. 

The duplicated media vehicle is added to the bottom of the media schedule. Using the layout option, you can now 
add in a new data item for Unit Type. Double click in the cell for Unit Type next to your new duplicated media 
vehicle, and change the size and color options to reflect the proper ad size. 

 

Simulate/Prototype a Media Vehicle 

You may wish to simulate/prototype a media vehicle for a schedule launch, or simply simulate/prototype a 
non-measured magazine. 

To simulate a media vehicle right-click on the title of the media vehicle and a menu will appear.  Select Simulate. 

 

For further information, please call your Telmar client service representative or email​ ​accountservices@telmar.com​    ​- ​14 - 

mailto:accountServices@Telmar.com


 

User Manual - Media360   

 

Firstly, you will be told: ‘Parent Media is (your publication), you will then be asked: ’Please enter a new Media name’. 
Type a name in the box and click on OK. 

 

Secondly, you will be asked: ‘what percentage of “(your publications)” readership should “(your publication) 
Simulation” have?’ Type the percentage in the box and click on OK. 

Thirdly, you will be asked: ‘what percentage of “(your publication) Simulation” readers will also read “(your 
publication)”? Type the percentage in the box and click on OK. 

You will then be presented with the simulation information 
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Navigation Menu 

Layout 

 

Click on the Layout button the screen is divided into Planning Calculations and Result Calculations.  To hide or show 
headings use the arrow buttons to move the headings across to the right-hand box.  The Up and Down buttons 
allow you to alter the order of the headings, and then click on OK. 
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Sort 

Select the column heading you wish to sort and click on the Sort button. 

By default the column will be sorted in descending order.  Right-clicking on the column and selecting Sort Ascending 
will then sort in lowest to highest order. 

Another way to sort is to right-mouse click on the heading of the data item you want to sort by. A menu will display 
with options for sorting by Ascending, Descending, or by the order that the media vehicles were originally selected. 

What If... 

This facility calculates the amount of coverage - achieved and lost - for each publication by adding and subtracting 
insertion levels, chosen by the user.  

Click on the ‘What if’ button on the toolbar to display the What If input screen. 

Here you may choose whether or not to display plus (+), or minus (-) columns for the calculation. 
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Printing 

There are two ways to Print, click on the Print button or use the File menu and select Print and the Print Options 
window appears. 

 

Within the Printing Options window the Plan report is printed by default; you can also include the Frequency 
Distribution report by clicking the Frequency Distribution check box.  The Media and Total Columns can be edited 
before printing each report by clicking the Edit button. 

● To show only a top number of publications on your report; use the arrows or manually type in a number 
in the “Only Show Top # Media” section.  With this set, when printing, just those top vehicles will be 
included on the final printed report. 

● Click on the Target button to select all or some targets to be included in the print job. 
● The Plan Information button allows you to display general information that can be printed on reports.  

Once you have set all of your print options, click on the Print button. 
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Using Report Style Sheets 

Using the Print Preview option, users may configure a report layout, and then save it, and in the Printing Options 
dialog they can choose to make that specific report style sheet to be used when printing. 

Click on the Configure button within the Print Preview screen. Here you may edit the layout of the printed report, 
including: Report Setting, Title, Headers, and Footers. 

 

Click on the Preview Button to see the changes. 

Click on the save as button and name the Report Style. Then go to the Printing Options screen and under the report 
Style Sheet section click on Browse, and choose the file you just saved. Now when printing a reach and frequency 
delivery report, the printed report will always have the customized report style. 

  

 

 

 

 

For further information, please call your Telmar client service representative or email​ ​accountservices@telmar.com​    ​- ​19 - 

mailto:accountServices@Telmar.com


 

User Manual - Media360   

 

Graphing 

 

Click on the heading of the column you wish to graph, then click on the Graph button. A graph will be created 
showing the data in the default graph format. 

 

 

If you are working with multiple targets, when you choose to graph on a data item, all of the targets will be 
represented in the resulting graph. 
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Exporting Features 

 

Excel 

If you wish to export your report into Excel select the Export button on the toolbar or click on the File menu and 
select Export. The Export Options dialog will display. 

  

Within the Export Options Window, click on the export button to display further options 
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Power Point 

 

Media 360 now has the ability to export live PowerPoint slides directly from Media 360. This means that once open 
in PowerPoint, any editing done in the data will update the slide automatically. 
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Mixing Software 

Once the schedule is completed and saved, you may want to export the final reach and frequency results to a 
mixing application to combine with other media types created in other applications. 

Click on the File Menu, and choose; Export to…Schedule for Mixing. 

The Save As dialog box will appear. Make sure to give the file a name. The mixing file will have the file extension of 
*.DAU, and can be opened with Telmar’s media mixing application ADplus. 
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Reports 

Frequency Distributions 

The Frequency Distribution window shows the frequency with which the target audience is reached by the schedule. 

 

To view Frequency Distributions, click on the Frequency button on the toolbar, or click on the Options menu and 
then Frequency Distribution from the menu. 

To switch between multiple targets, click on the downward pointing arrow of the Target Market window to show 
other targets. To export to Excel, click on the export icon.    

You can now also group your frequency results together by clicking on Options button, and then Groups button. 
When you click on this button the following box appears with two options. This feature allows you to place your 
frequency results into groups and keep some displayed separately. An example of this follows. 
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If we wanted to see the first five frequencies separately but then place the rest of our frequency results into groups 
of three we would place a 5 in the box next to Show All Frequencies. Up to: we would also place a 3 in the box next 
to After That Show in Groups Of: 

 

N-Tile Analysis 

The N-tile analysis window is also known as a quintile distribution. A quintile distribution is like a frequency 
distribution, but rather than displaying reach at each frequency level, it groups the audience reached by the 
schedule into five equal parts, and averages the frequency for each group. This can be changed to any level of 
groups (terciles), by adjusting the arrows next to “Show N-Tiles” on the N-tiles dialog window. 

Report columns include: Impressions, Impressions %, GRP, and Frequency. You can select which columns to display 
from the ​Layout ​menu.  
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IRF/Schedule Duplication 

 

Schedule duplication is produced by the IRF function within Telmar’s Media360 application. It represents the 
duplicated Impressions within a print or other respondent data produced schedule. The typical question it answers 
is, “Which of a combination of insertions in magazines produces the lowest duplication among the magazines 
used?” 

  

Using Filters 

Filters are useful for subtracting a sub-group from your existing target. You can add as many as you like. 

Start by clicking the Add button, you will see a standard coding screen. 
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Enter/select the coding for the filters you wish to use and click ​next​. The screenshot above shows age breaks. The 
Delete​, ​Rename ​and ​Edit Coding ​buttons can be used to make changes. The ​In Use ​column is so you can choose 
to only see the results of a few of them. It is a useful way to turn individual filters on and off without deleting them 
from your schedule. 

The ​Options ​button allows you to load and save your filter definitions to an file for later use. The Save and load 
dialog box will default to the user directory and as many filter files can be loaded as you require. 

Clicking OK from the filters dialog will tab your filters and display them as tabs along the bottom of the screen. 
Entering inserts will calculate reach and frequency results  for the main target and for all of the filters you have 
setup. Planning a campaign is done in the normal way, but with the “**Total**” tab highlighted. Click the relevant 
tab to see the reach and frequency filtered by that filter. 

Grouping Media Vehicles 

Groups are useful in that they allow for select vehicles to be “grouped” together to ultimately display the combined 
reach delivery for that group in the totals of the reporting window. Groups and Filters cannot be used together 
within the same target. 
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Click the Add button to display the grouping dialog. Check the pubs to be included in the group. Click the Rename 
button to give a proper label, and click OK. 

The new group called Airline Publications will display at the bottom of the totals in the reporting screen. 

Options 

Use the Options Menu to further customize Media360 to work the way you want. 

User Defaults 

This tab is where most of the options live for the way behavior of the application. Not all settings apply to all 
countries. The main options are below: 
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Show Totals Grid​ - This option will set the way the total results are displayed on screen. The choices are 
vertically or horizontally. 

Show Plan Information - ​Show plan info turns on/off the option to show the plan informational box before 
saving a project, or printing the final report. Users may document any information they like and have that be 
a part of the final report. 

Show Startup Dialog - ​Turns on or off the Startup Wizards dialog screen when starting Media360. 

Media List Differ Between Targets - ​When this option is turned on, it allows for different targets to have 
different media vehicles. When this is turned off, all targets will have the same list of media vehicles. 

Use Thousands Separator - ​This will display commas in Reach, Impressions and Cost data fields. 

Auto Sort Media - ​When loading any additional target files (*.DEU), this option will automatically sort the 
media vehicles in that target file in the same order as the first original file. Useful when working with 
Multi-Target schedules. 

Show Line Numbers - ​This option will add a number to each media vehicle to the left of the media vehicle 
name. 

Show Target Hints - ​Displays a pop up tooltip with the entire target name displayed when hovering the 
mouse over the target tab on the schedule input screen. 

Show Grand Total for Multi-Schedule​ - Display a grand total for all schedules. 

Show Grand Totals for Multi-Targets - ​Display a grand total of multiple targets. (Targets must be mutually 
exclusive.) 

Ratings Rounding Method - ​Controls how the GRP’s are rounded to the next available spot level. The 
default option is Down, but can be changed to Up, or Closest. 

Simple Existing Target Selection -  ​Display a list of previously created target DEU files in a listing formatted 
window. When this is not enabled the standard windows dialog will be displayed. 

Display New Targets before existing Targets - ​When enabled will bring up the screen to create a new 
target first, instead of the listing of previously created target DEU files. 

Prompt for Target Filename - ​Turning this option on will prompt the users to name the DEU file before it is 
created. If this is not on, Media360 will automatically name the DEU file with the target name as it was 
coded, and append the survey code to it. 
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Layouts 

Each of the wizards available in Media360 can be configured with different data items depending on the users 
needs.  Each wizard can be saved as a default.  The Media Columns in the top section of the layout screen are 
displayed on the scheduled portion of the screen. The Total Columns are what’s displayed at the bottom of the 
schedule and will represent the totals for the entire schedule. 
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In Cell Graphics 

When In Cell Graphics is enabled, the schedule input screen will show bars within the data items for % Coverage, Reach 
(000), and % Reach representing the values in the cell 
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Composition 

This section of options sets the application to create a composition base file when tabbing the target. 

  

Do not tab a composition when creating new markets 

When enabled the application will not create a composition base file. 

  Composition Options 

When enabled the application creates a composition base file automatically. 

Never create when Multibasing 

When enabled the application will not create a composition file if the survey is a Multi-based survey. 
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Wizard Defaults 

 

Cost Rank Default Cost File 

Users can set up a cost file to always apply costs to the media vehicles in a schedule. Choose the file by 
clicking on the button with the 3 dots. Click on the file you want, and click OK. This cost file will always be 
used by default. 

Optimization Defaults 

These settings are for the Optimization mode 

Maximum Insertions 

Use this to manually add the maximum insertions per media vehicle when running an optimization. This 
option is greyed out if Auto from Dictionary File is turned on. 

Auto (From Dictionary File) 

Automatically will populate the maximum insertions per media vehicle when running an optimization. This is 
turned on by default. 

Always Use Formula Based Calcs 

Use formula R&F when doing an optimization. (Probability surveys only) 
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Show Cost Graph on Completion 

When this option is enabled after an optimization is run, the resulting schedules will be automatically 
charted based on the amount of money spent in each medium. 

 Target Calculations 

  

Show Target Stability Level 

Displays an asterisk within the Sample Size at the top of the schedule input screen when the target is 
relatively unstable. 

Show Stability Column for Media 

Displays an extra column on the schedule input screen that will show an asterisk for unstable media 
vehicles against the selected target. 
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Glossary 

Audience (000) - ​The number of people in a target audience who have seen a single (or Average) issue of a 
publication/media vehicle 

% Audience - ​The number of people within a target audience who have seen a publication/media vehicle, 
expressed as a percentage of that target audience. 

Net Reach (000) - ​The number of people in the target audience (shown in units of 1000) exposed to a schedule at 
least once.  

Net % Reach - ​The number of people exposed to the schedule at least once, shown as a percentage of the target 
audience 

Unit Cost - ​The cost of a single insertion/use in a given publication/media vehicle. 

Insertion/Uses - ​The number of advertisements placed in a publication/media vehicle. 

Total Cost - ​The number of insertions times the unit cost, summed together. 

Avg. Frequency - ​The average number of times each person is exposed to the media schedule 

Gross Impressions - ​The total number of exposures of a target audience to a schedule regardless of the number of 
times one person is exposed.  The sum of all the publications/media vehicles cume impressions 

GRP (Gross Rating Points) - ​The sum of the ratings for a schedule.  Each percentage point in the % Readership 
column denotes one rating point. 

CPM - ​Cost Per Thousand - The cost of reaching 1,000 different people in the target audience. 

Composition Index - ​An index shows how likely someone in a target audience is to have seen a publication/media 
vehicle.  It is calculated by dividing the percentage of a publication’s readership that is within the target audience by 
the percentage of the composition base that is in the target audience, multiplied by 100. 

Composition Audience - ​The number of people in the composition base who been exposed to a single (or average) 
issue of a publication, show in units of 1000. 

% Composition - ​The number of people within a target audience who have seen a publication, expressed as a 
percentage of those who have seen it in the composition base (normally the group entered as the Universe). 

Adjustment Factors - ​The readership/audience of a publication/media vehicle will be adjusted by the figure 
entered here.  

Impact Factor - ​This factor allows you to account for qualitative values of different ads in the same schedule (for 
example page size or B&W / Color). 

Exclusive Reach (000) - ​Displays the exclusive readers/viewers of the publication/media vehicle expressed as a 
whole number. 
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Exclusive Reach % - ​Displays the % of exclusive readers/viewers of the publication/media vehicle.​Effective Reach 
(3+) - ​The percentage of different people in the target audience exposed to the media schedule at a specified 
frequency level, usually 3+. 

Population - ​The number of people in the target population. 

Sample - ​The number of respondents within the survey which the population figure is based upon. 

  

  

 

 

For further information, please call your Telmar client service representative or email​ ​accountservices@telmar.com​    ​- ​36 - 

mailto:accountServices@Telmar.com

